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1. Selecting Your Equipment

Camcorder Options

As of 2012, a good camcorder to produce video for the internet or to view on HDTVs can be
purchased for under $1000. These new consumer HD camcorders use the AVCHD format that
looks great on the internet and on HDTVs and even come with basic software for simple editing
on Window PCs. Choose one that has an external microphone input and has manual controls for
exposure, focus, and white balance adjustments if you want to get good audio recordings and be
able to handle difficult lighting situations.

The free software to edit AVCHD video usually requires at least a dual-core PC with a minimum
of 2 gigs RAM and it will usually display video in a small window and might be sluggish in
operation. This may not be a problem if you only want to produce an occasional simple video
with a few cuts and might be all you need to get started. If you need to work on more complex
videos, the AVCHD format currently requires powerful quad-core 17 computers with a minimum
of 4 gigs of RAM.

There are three under $1000 AVCHD options: HD pocket or flip camcorders ($100 -$200),
palm-style camcorders with manual controls ($600 - $1500), and DSLR still cameras with video
capabilities ($900 - $2000). More professional AVCHD camcorders with XLLR audio input
begin at about $2000. A brief comparison of the low-cost options for beginners follows below.

Pocket Camcorders

These small HD camcorders can produce great footage for web viewing but they have
limitations. They work well in static shooting situations on tripods for interviews and as a
locked down second camera for performances or demos.

These are some of the problems with using pocket camcorders and some solutions:

* Poor image when shooting in low light - use lights or only shoot in well-lit settings
* Poor image when zoomed in - best to shot only at the widest zoom
* Blurry image when panning or moving quickly - use a tripod and move very slowly
* No inputs for external microphones - use a separate audio recorder

Palm Camcorders

Those with manual controls and inputs for external microphones are the most versatile and
easiest to use. They can be used in all situations, static interviews and fast moving events, and
can produce usable images even in low light. For beginners and those who only make an
occasional video, this is the best option.

DSLR Camera

There’s been an explosion of excitement in these new cameras because of their stunning images
even in candlelight. Most DSLRs can use external microphones for interviews but it can be
difficult to adjust the manual controls on the fly for performances and demos. These are best for
still photographers who occasionally want to shoot videos.



Recording Audio

Many ethnographers have developed skills in getting good audio recordings of interviews that
can then be enhanced by the use of video. While consumer camcorders can get great video
images, it is often a challenge for low-cost camcorders to get high quality audio recordings. If
your camcorder does not have the ability to use external microphones, then you could use a
separate digital audio recorder and use those audio tracks rather than the ones from the
camcorder when editing.

External Microphone Options

Lavalier microphones are clipped on to the interviewee and get much better sound than the on-
camera microphone — clearer and louder. Some are very directional and only pickup the
interviewee while others have a broader pickup pattern and can pull in the interviewer too.

Shotgun microphones are usually very directional to pickup only sound from about three feet
away and reject sounds from behind or to the side. Do tests to discover the characteristics of
yours.

Stereo microphones usually have a wider pickup range and are great for music or group
discussions. Do tests to discover the characteristics of yours.

Portable Lights on Stands

Bringing lights to a shoot gives you more options but also adds complications because there are
more things to lug around and learn to use well. They will come in handy when the best location
is in a dark area or the interviewee’s face is poorly lit. Though it takes effort to learn how to use
lights effectively, they open up more possibilities on where to position your subjects and also
make them look better.



2. Essential Camcorder Operations

Objective 1 — you will get the camcorder ready and make and review a simple recording by
completing the following tasks:

* Check the battery level and, if low, charge it.

* Insert the battery onto the camcorder.

* Insert media into the camcorder.

*  Mount the camcorder on to a tripod.

* Turn the camcorder on/off.

¢ Switch to the movie mode.

* Switch between standby/record and make a short test recording.
* Switch to the playback mode and review your test recording.

Camcorders operate in very similar ways and after handling several, many people can do these
tasks without referring to the user manual. If you can perform all of these tasks, skip to the next
objective.

Those new to camcorders or unsure about operating them need to read the user manual and look
up the procedures to perform the tasks for Objective 1.

Objective 2 — you will learn to shoot in the auto mode and to avoid difficult situations and
practice easy solutions to common problems by experimenting with shooting in the following
situations to learn the characteristics of your camcorder:

* Have the light source in front of the subject.

* Avoid backgrounds brighter or darker than the subject — high contrast.

* Avoid bright-lit windows in the background or lamps/lights next to your subject — hot spots.

* Avoid having any movement in the background or foreground because it can make the auto-
focus throw the subject out of focus.

* Ifyou go from indoors to outdoors or vice versa and the image looks bluish or orange-
yellowish (white balance problem), try turning your camcorder off and then on.

* Shoot zoomed out to widest and don’t zoom in — everything will stay in focus.

Shooting on Auto

Most consumer camcorders are very efficient at delivering excellent video in the auto mode in
ideal situations - the scene has enough light and is not high-contrast without unnecessary
movement in the background or foreground.

Objective 3 — you will switch the camcorder into manual mode, and make the following
adjustments to the focus, white balance, and iris (lens opening/aperture):

Focus

* Zoom in all the way and aim at three objects that are at different distances away from you
and bring them into focus — for example,
- first at 5 feet away
- second one at 10 feet away



- third one at over 20 feet away.

White balance

* Go indoors and cycle through all the pre-set white balance options and see which one makes
colors look the most correct to you.

* Point the camcorder at something white and do a manual white balance and compare it to the
pre-set white balance options. Which one looks better to you?

* Go outdoors into a shady area and repeat the steps of comparing the pre-set options to a
manual white balance.

* Go outdoors into the bright sunlight and repeat the steps of comparing the pre-set options to a
manual white balance.

* Switch the camcorder into the manual iris control mode.

* Point at on object in front of bright light or a window.

* Adjust the iris until the object is exposed properly.

* Ifyour camcorder has a back light feature, switch it on and compare it to the adjusted manual
iris display.

* Point at a brightly lit object in front of a very dark background.

* Adjust the iris until the object is exposed properly.

* Ifyour camcorder has a spotlight feature, switch to the auto mode and compare the two.

If you can perform all of these manual adjustments on your camcorder, skip to the next objective
on shooting styles. If you need more information, read the following sections.

Using Auto or Manual Controls
Why manual controls

Beginners who have not mastered photographic exposure controls can get good results just using
the auto mode if they know how cameras determine exposures and how auto focus works — see
Objective 3. But it’s not always possible to avoid problem situations so it’s best to learn how to
make manual adjustments and practice using them until making adjustments feels natural. Then
you can handle any situation you encounter more efficiently and shoot with more flexibility and
confidence — especially for event shooting.

Shooting in manual
In interviews, you might only need to make the adjustments at the beginning. In demos and
events, there could be more changes in lights and movement that require ongoing adjustments.

Three basic controls you must understand are:

* focus
* white balance
* iris/aperture for exposure



Locking the Focus

Since auto-focus systems can shift the focus away from your subject if there’s other movement
in the frame, learn how to set the camcorder into manual focus to prevent it from putting your
subject out of focus.

Put your camcorder into the manual mode and select manual focus. Then zoom in on your
subject all the way and bring it into focus.

When zoomed out to the widest, your image will appear in focus but may not be if you decide
later to zoom in when recording.

For demos and events, it’s best to shoot in the manual mode and be prepared to refocus all the
time. It is possible to shoot in the auto focus mode and hope that your camcorder adjusts
properly, but this can be unpredictable. For events, it’s best to shoot wide which keeps things in
focus.

White Balance

The first thing to check when preparing to shoot is to see if it’s displaying the correct white
balance for the light source. The color “white” appears differently in photography in bright
sunlight, shaded natural light, and the different types of artificial lights. If the color of your
composition is too blue or too orange, then the camcorder is not making the correct white
balance setting and you must do it manually. Whenever there is any change in the lighting
source, white balance must always be checked.

Camcorders have pre-set white balance settings for indoor incandescent lights (light bulb icon),
bright sunlight (sun icon), and outdoor shade (black sun icon). If the pre-set doesn’t look
correct, then you must do it manually.

Auto Exposure

The camcorder’s light sensor analyzes the whole image and sets the exposure to an average
value. This works well if the image is evenly lit without areas that are much brighter or darker
than the rest of the image. But if there is a bright light or window behind your subject or if your
subject is spot lit and the background is dark, then your subject will not be exposed properly and
you must correct it by manually adjusting the iris/aperture setting.

Exposure Controls

In high contrast lighting situations, you have to adjust the lens opening or aperture by either
opening or closing the iris setting to get a proper exposure.

See how this works by putting the camcorder into the manual mode and selecting the iris control
option. Then shoot with a brightly lit window or the sun in the background (anything much
brighter than your subject) and use the iris adjustment to correctly expose your subject. Or shoot
with your subject brightly lit in front of a very dark background.



3. An Introduction to Shooting Styles

Objective 4 - this brief orientation on camerawork styles will help you explore some basic ideas
about composition and assist you in preparation for your initial shoots.

There are many ways of shooting video and which one is right for a particular shoot is a matter
of personal choice and creativity. If you haven’t formed any strong preferences, look at similar
shoots and see what appeals to you and ask yourself what you like about them. Then experiment
and evaluate the result to see how it feels doing it and if it accomplishes your goals.

Framing Movement

Video begins with the same composition goals as still photography and expands with a different
relationship to movement. With video, movement is often the focal point of compositions and is
used to attract or focus the viewer’s attention. This can be either the movement of your subject
and what’s going on in the frame or the movement of the camera panning and zooming. Most
shooters use a mixture of these two styles of camerawork.

When, why, and how you move is according to your goals and preferences. Of course, the more
interested a viewer is in what is being said or seen, the less aware or concerned they probably are
about how it’s being presented.

Still and Smooth

A basic style of shooting and the easiest to do resembles still photography with little or no
zooming or panning. All the attention is on the subject and viewers are not aware of the process
of shooting. The camera is locked down on a tripod to stop any movement but ready to smoothly
pan if the subject shifts out of the frame.

All the movement is of the subject’s face or body and the camera moves usually because the
subject has shifted his/her position. Any zooming or panning is done very slowly and smoothly
so the viewer is usually unaware that it’s happening. Shifts are in response to the subject’s
movement or to emphasize what they are saying.

Constant Movement

The opposite style to being mostly still is the “always moving” camera that constantly reframes
to give emphasis to what’s being said or to make a static situation more visually engaging. This
can be smooth movements or quick and even jerky movements. The panning and zooming can
be done subtly so that the viewer doesn’t notice and the reframing is precise and without
hesitation. Or it can be obviously hunting for the new composition and making the viewer very
aware of the process of shooting as commonly seen in Reality TV shows.

Tripods

Use tripods that can pan smoothly and be locked down without shaking for interviews, demos,
and stage events. Regardless of the shooting style, decisive camera movement where you move
from one composition smoothly to another requires practice to do well and informatively.



Framing Interviewees
Three ways to frame interviewees are:
* Wide — upper torso to top of their head

* Medium — top of shoulder to top of their head
* Close-up — head only

Where you position them in the frame is a matter of personal preferences. With taking photos
being such a common part of life now, people have formed habits and may have even thought
about composition. If you want to explore ideas on composition more, here’s some good info:

Close-up: http://en.wikipedia.org/wiki/Close-up

Rule of Thirds: http://www.digital-photography-school.com/rule-of-thirds
http://photoinf.com/General/ KODAK/guidelines_for better photographic_composition_rule of
_thirds.html

Headroom: http://en.wikipedia.org/wiki/Headroom_ %28photographic_framing%?29

Interviewee’s Movement

If the interviewee uses his/her body dramatically, a wide shot gives them space to move their
arms within the frame. Then it’s possible that the interviewee may never move out of the frame
and the camera can be locked down. This is the easiest for beginners to do.

If the interviewee is very still and doesn’t gesture with his/her arms or head, a wide shot can
seem very static and not interesting visually. In this situation many will then use a medium or
close-up shot to get a more engaging image.

Both require much more attention than wide shots and you must always be ready to adjust if they
suddenly shift. A slow pan can be used if you don’t want your camera movements to be obvious.

Some of you might get more adventurous and zoom in and out using all three types of shots.
This works best when it enhances what’s being said and is not just random movement. Since
you must always be watching and listening, this is the hardest to do and you must practice to do
well.



4. Setting Up for an Interview

Objective 5 — you will use a tripod, an external microphone, and artificial lights to do some test
interviews:

*  Mount your camcorder on to the tripod

* Ifyour microphone has a battery, test it and insert it into the microphone.

* Connect the microphone to the camcorder and do a sound test with headphones — have at
least 10 feet of cable.

* Position your interviewee in front of a background with about the same amount of light and
do a short test recording.

* Position your interviewee in front of a very dark background and do a short test recording.

* Position your interviewee indoors with outdoor light shining in background, use some
artificial light on the interviewee, and do a short test recording.

* Position your interviewee indoors with artificial lights shining in background, use some
artificial light on the interviewee, and do a short test recording.

Read the following section and then perform the tasks for this objective.

Interview Basics
Good Audio

Interviews are primarily opportunities for people to tell their story so the most important thing is
first to find a quiet place without distracting background sounds that make it hard to hear or
understand them. The quality of the audio in interviews often is more important than the video.

Viewers will continue watching poorly shot video when they are very interested in the subject
and can hear what is being said but often stop watching well shot video if they can’t hear or
understand what’s being said.

For the best quality, use a lavaliere microphone with 10 to 15 feet of cable for flexibility in
positioning.

Using Lights

Having lights on a shoot gives you more flexibility in deciding where to position the interviewee.
If their preferred spot or the setting with the best background is dark or has high contrast or
mixed lighting, then you can use your lights to compensate for these problems. If you’re
shooting during a hot time of the year, be careful not to overheat your subjects.

Here are two problem situations and solutions:

Too dark

Putting a soft diffused light off to one side of the subjects can make their faces stand out better
and cast an interesting shadow on one side of their face too — Rembrandt lighting effect. If your
subject wears glasses, this also avoids having a distracting reflection in the middle of their
glasses.
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Having a dimmer on the lights adds more flexibility by giving you the ability to add just the right
amount of light for your needs. Many newer camcorders are good in low light and only need a
little extra lighting.

Mixed lighting source

If your subject is lit by artificial lights, a window in the background will shine bluish outdoor
light during the day. If the light on your subject is coming from outdoor light through a window,
any artificial light you use will cast orange-yellowish light on your subject.

Some people want to use this mix of outdoors and artificial lighting as an effect and it is an area
of much creativity and experimentation. But if you don’t like this mixed lighting effect and want
to keep the lighting the same, here are some suggestions:

* Use artificial lighting that can also give outdoor color temperature
* Use a blue gel to filter artificial lights to match outdoor lighting
* Close the window shades or curtains to block out outdoor lighting

Here’s more info on some simple uses of lighting and reflectors:

http://provideocoalition.com/index.php/aadams/story/the_simplest fastest interview_lighting_se
tup--ever/

http://en.wikipedia.org/wiki/Rembrandt lighting

Background Statements or Not

There are three basic ideas of choosing a background and it’s a matter of personal choice and
what you find at the interview location. All might require using artificial lights if there is low or
mixed lighting in the background.

* One is to position the subject in front of a background that says something about them by
giving a sense of their personality.

* The opposite is to only light the subject and have a dark or neutral background to focus
all the attention on the subject and eliminate any visual background distraction.

* The third is place the subject in front of a visually interest background that has nothing to
do with the subject.

Shooting Steps
1. White balance check — carry a sheet of white paper in your pocket
2. Exposure check - if not correct, switch to manual mode and adjust the iris
3. Focus - shoot in the manual mode
4. Compose shot and check the recording indicator after pressing the button
5. Monitor periodically:

- audio level with headphones
- battery and recording media
- lens for dirt or smudges
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5. Basic Video Editing Introduction
Objective 6 — you will transfer video into your computer.

* Connect your camcorder to your computer
*  Or, insert the SD card into your computer or SD card reader
* Run the video editing program and transfer your video into the computer

If you know how to do this, skip to the next objective. If you don’t, read the tips below and then
transfer your video files.

Computer and Operating Systems

Consumer HD camcorders usually come with software that run on computers that must have at
least a dual core CPU and Windows 7 or Vista operating systems installed. You must have 20
gigs of free hard drive space available to easily work on one hour of video.

Some HD camcorders offer Mac OS 10 software but most don’t. If not, you could try using the
iMovie program that comes with Mac computers.

Connecting to the Computer

Most consumer HD camcorders connect to the computer through a USB cable. After attaching
the USB cable to both, turn on the camcorder and start the video-editing program.

It’s also possible to just use the SD card with your video files and insert it into your computer’s
SD card readers. If your computer doesn’t have a SD card reader, get a USB card reader that
supports SD cards. This makes it convenient for those who are using a shared camcorder since
they only need to have the SD card (and not the camcorder) to work on their video.

Transferring Video Files

It’s good to have a separate folder for each video project to keep things organized. After making
a new folder, transferring the video files from the camcorder or SD card.

Objective 7 — you will roughly cut out all the good segments from the raw video files and upload
these good segments to YouTube.

* Review your raw video and cut out the good segments

* Trim unnecessary footage from the beginning and end of each segment
* Arrange good segments together into 15 minute blocks

* Insert fades/transitions between segments

* Upload edited video on to YouTube

Here are some common terms used in video editing:

* Browser/Bin — displays your raw video files
* Clip - video files
¢ Segments — parts or collections of clips
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* Timeline — place to arranges segments

* Viewer - displays clips using VCR control buttons

* Timecode - displays position or length of video as hour:minute:second:frame.

* Tracks - video and audio clips stacked over each other on a timeline.

* Playhead - like the cursor in word processing, it shows your position in a clip or timeline

Gathering Good Segments

After starting your video editing program and transfer your raw video files into the timeline,
review the raw clips from the shoot and look for good segments. Separate good segments from
the raw video clip by first doing a rough cut using the splitting tool. After viewing all your raw
clips, use the trimming too to remove unnecessary video. Save your editing and upload the clips
to the Internet for sharing.
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6. Shooting Demonstrations and Events

Objective 8 — you will do practice exercises listed below to help prepare you to shoot a demo:

*  Mount your camcorder on a tripod.

* Zoom out all the way.

* Practice panning smoothly between two objects without jerks or hesitations at the
beginning or end of the pans. Continue until you can it do easily.

* Zoom in all the way.

* Practice panning smoothly between two objects with as little jerking as possible at the
beginning or end of the pans. It’s very difficult but practice for a few minutes.

* Shoot a process like a meal preparation.

* Shoot someone performing.

* Shoot a five-minute long story about “A day in the life” of a friend or pet.

Review the information about shooting styles in Lesson 2 and read the section below.

Visual Storytelling

While interviews are often visually still and primarily oral, good videos of demos and events can
be interesting even without audio and, like a slide show, function as a photo essay series.
Dynamically visual storytelling can make viewers feel as if they were there and understand
what’s happening. Through various perspectives, from wide overall shots to intimate close-ups,
viewers can see what was going on and, sometimes, even know what it felt like.

Many Perspectives with Purposeful Movements

Shoot demos and events as you would a series of still photographs with the additional ability to
show the progression of steps in a process and spatial relationships between activities, people,
and things. Watch the action unfold, plan your next move, and know what you’re trying to
capture. When you pan with intent, it won’t seem like random movements that result from
looking at the world through the camera lens. Experiment and take chances and allow yourself
to get inspired.

Anticipate and Move

Think about the process you’re watching and try to anticipate what might happen next. Don’t
hesitate to move into a better position if you can’t see what’s going on. Be mindful of being in
people’s way at events and be “ninja” like in your actions but don’t be afraid of being bold and
Spontaneous.

Keep Recording

While the primary challenge is visual storytelling, getting good audio is still necessary so listen
for interesting things being said. Have enough media and batteries so that you begin recording
early, in anticipation, and continue shooting as you wait for good things to happen or be said.
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Zooms

Beginners should avoid doing zooms as part of a shot except to reframe when using a tripod until
they’ve studied and thought about its use. Zooms are difficult to use well and especially when
shooting handheld unless you’re doing the shaky camera style.

Handheld

In processions where the subjects are walking, it’s often necessary to do handheld camerawork
and have the ability to shoot while walking. Rather than shooting far away from the action and
then trying to zoom in, it’s better to get close and stay zoomed out wide. Then you can get good
audio of the participants and your image will be in focus. Also, it’s harder to get a steady image
when you’re zoomed in without a tripod. Practice walking slowly and without bouncy steps to
get steady shots while moving.

Be Open

Approach shooting as an adventure and be prepared for the unexpected. The best things that
happen are often not what you anticipated. Keep recording until you’re ready to stop and pack
up. People will often say great things at the end after you think the session is over.

Also, things that might initially appear to be problems can lead to good outcomes if you don’t
panic. Try to keep a good attitude about what you’re experiencing and enjoy the challenge of
describing a process or event. Let magic happen.

* Describe what’s going on visually

* Pan to show relationships and process

* Listen to what’s being said and capture audio

*  Watch and anticipate the flow of action and start recording early
* Be ready for surprises by continually recording

* Even accidents can turn out good, so don’t panic

Obijective 9 (optional) - you will do practice exercises listed below to help prepare you to shoot
an event without a tripod (don’t use flip camcorders):

* Zoom out all the way.

* Practice panning smoothly between two objects/people without jerks or hesitations at the
beginning or end of the pans. Continue until you can it do easily.

* Do a practice shoot walking and making manual iris adjustments:
- Shoot your subject in front of bright lights.
- Shoot your subject spot lit in front of a dark background.

Review the information about shooting styles in Lesson 2 and the section above on visual
storytelling and then do the practice exercises for this objective. Other practice suggestions:

* Take the opportunity to shoot any event or stage performance.
* Remember to shoot the audience to give a sense of who was there and their reactions.
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7. Editing Stories

Objective 10 — you will make a simple story from the good segments and add text for openings
and end credits.

* Arrange good segments into coherent story
* Insert any necessary transitions
* Add a opening and ending

Computers have made video editing much easier by giving you the ability to experiment without
fear that you’ve changed the raw video. In the same way that word processing gives writer more
flexibility in the writing process, you can try different ways to arrange your raw video into a
polished story. Make a simple movie to learn the basic steps in the process by learning the
common terms, review the steps in the process listed below, watch the example video, and then
make a short 3 to 5 minute movie.

Telling Your Story

Arrange these good segments in an order to tell your story. Play it back and evaluate whether it
works. Fine-tune it by rearranging the clips and cutting out parts that are not needed — every
second must serve a purpose in the storytelling.

As with writing, design a narrative progression that has an evocative beginning and weaves
interesting information together towards a good ending. After you’ve designed an interesting
and coherent narrative, take a break and then review it again.

Finishing/Polishing Your Movie

If necessary, add video dissolves or audio fades to smooth out the transitions between clips.
Make opening titles and fade into the movie. Make end credits and fade out of the movie.
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8. Basic Final Cut Pro Editing

Final Cut Pro (FCP) is a powerful program with multiple ways to accomplish the same thing -
which allows skilled editors to work according to their preferred methods. The workflow
suggested below mimics the basic handling of film and is intended for users without developed
computer video editing habits. This is just a starting place and after editing video often, you’ll
develop your own methods through experimentation and studying the manual or online help.

The examples here use FCP 5 but versions 1 to 6 operate in basically the same way though the
wording of the screen options and menu labeling may be slightly different. These instructions
are for the DV format and if you’re using another video format, then choose your format instead.

It is best to store raw video files on a separate hard drive or partition and avoid file
fragmentation, which is often the cause of sputtering video playback. When video files are
broken into smaller parts, the hard drive read head has to jump around the hard drive’s disc and
the video may not playback smoothly.

Main Windows and their Functions

Using FCP begins with learning how to use the four primary windows to design your movie:
Browser - management window for both raw video clips and sequences (arrangements of clips).
Viewer - displays individual video clips using VCR controls.

Timeline - the workbench for designing/arranging clips into sequences.

Canvas — displays sequences on the Timeline using VCR controls.

Effects Tools RULEETE Help
Minimize #M

Send Behind
Arrange [ 2

Tool Palette
Viewer

€1

To open any windows, click on the
top menu “Window” button.

Audio Meters 4

v Browser 384
Effects 35
Favorites 3#6
Export Queue

Browser

Browser
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It displays the project name on one tab and a listing of Effects on the other tab. If you close the
Browser window, the project will be closed.

Video clips/files are imported into the Browser and the clip’s info is displayed. All sequences
are also created and displayed in the Browser.

Finished sequences are also exported from the Browser to all the distribution formats. Two
useful fields are “Name” and “Duration” and novices initially don’t have to be concerned with
other fields.

The tab labeled “Effects” lists all the video and audio transitions and filters.

Viewer

|
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Use the Viewer’s VCR controls to playback clips and to precisely mark/designate the beginning
and end of a segment. The tiny yellow triangle or “playhead” displayed in the white time bar
shows where you are in the clip.
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Video or audio tracks have separate tabs.

See the manual for info on using filter and motion settings.

Timeline
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Sequences are displayed in the Timeline graphically as filmstrips. It is the workplace for
designing/arranging clips and sequences into coherent stories.

Canvas

L

‘m ®®Q®® e I

It displays the video from the Timeline. The tiny yellow triangle or “playhead” displayed in the
white time bar shows where you are in the sequence.

When you click on a sequence in the Browser, it will open a tab in the Timeline and Canvas,
You can switch between multiple open sequences by clicking on their tab.

Audio Meter
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It displays the audio level of both clips in the Viewer and sequences in the Timeline/Canvas.

It allows you to make sure that the audio is played back at a consistent level with the loud parts
not going into the red section and staying around the -12 range.

Simple Editing Process
Capturing

Your camcorder must be turned on before starting up FCP or the program will not control it.
Follow the instructions for “Capturing Video” first and then return to the next step.
Turning Camcorder Off

After you’re done capturing, exit the program and turn off the camcorder — it’s not needed
anymore in the editing process.

When starting up FCP to edit, click “continue” if the program notes that there isn’t any firewire
device connected — this warning can be turned off.

Reviewing Your Video

Create a new sequence by clicking on the Browser window, pressing cmd-n, and naming it — for

29

this example: “raw”.
Click on the “raw” sequence to open it in the Timeline.
Select a raw video clip in the Browser and drag it onto the “raw” sequence on the Timeline.

Press sht-z to see the entire Timeline.
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Identifying Good Segments

For your first time, treat the video clip like film and roughly cut out segments in the Timeline
that you want to use. Leave a few extra seconds before and after the segment you cut.

When you find a segment in the Timeline,
press “b” for blade to switch to the razor tool
and clip at the beginning and end of good
parts to cut it from the rest of the clip.

Press “a” to go back to the selection tool and then drag segments you just cut up to the next track
above.

An example of a
good segment raised
to an upper track

Turning snapping on makes this easier because snapping will keep it in the same place along the
Timeline when you move it to the upper track.
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The snapping icon in the Timeline
is green when on, gray when off.

Clicking on it toggles it on and off.

Work your way through all the raw video until you’ve found all the good segments for your
movie.

Copying Good Clips

After finding all the good segments, click on the Browser and create another sequence by
pressing cmd-n (named “good” in this example) and then click on it to open it in a new tab on the
Timeline. Now you’ll have two sequences active in the Timeline — “raw” and “good”.

Click on the tab in the Timeline labeled “raw” to make it active and select all the clips that were
cut and raise them to the upper track.

Copy all of these clips.
Click on the tab labeled “good” and paste the good segments into it.
Press sht-z to see all the clips in the sequence.

Telling Your Story

The clips just pasted into “good” will all be in the same relative position on the second track as
they were in “raw”.
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Use the empty first or bottom track to rearrange them in the new order by dragging them
individually or as a group.

Design a progression of these segments to construct your narrative by dragging the clips on the
lowest track in the order you want them to appear — start with the beginning.

[ raw !

0| =| Avl2a0 ] [l

It’s good to have snapping on when you do this so that the dragged clip will snap to the adjacent
clip without leaving any gap or overwriting portions of the adjacent clip. Do some test dragging
at first to see how this works.

If there are clips on the second track at the beginning on the left side of the Timeline, drag them
over to the right side to make room.

Also notice how clips on the upper tracks will cover or hide the ones below them when played
back in the Canvas. Do some tests at first to see how this works.

Audio Monitoring

When you’re making your final version, use the audio meter window to make sure your level is
consistent. If the audio level goes to the top of the meter and flashes red, you must lower it. If
the louder sections are below the “-18” level, it’s probably too low and you’ll have to raise it.
Do this for individual clips in the Timeline or groups of adjacent clips if they all have to be
raised to the same level.

Adjust the audio level by first selecting or highlighting them and then using the menu options or
keyboard shortcuts to make changes.
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Composite Mode >
Alpha Type >
Reverse Alpha

al:

Important FCP Tips
Using Copies vs. Raw Clips

Lowering the audio
level of a clip selected in
the Timeline.

Also done by using the
keyboard shortcuts
listed on the richt
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Make all changes to copies and not the raw clips. In addition to the cut-paste method described

above, you can drag copies from the Viewer to the Canvas or Timeline. Leave the clips in the
“raw” sequence in their original order and untrimmed — to always preserve the ability to view

everything captured from that tape.

A white time bar without gray dots indicates that this is a raw video clip:

Raw and untrimmed clip

I"—ﬂJ'—"‘"—"M — l@@o@@ llm:t:::mll

Gray dots in the white time bar indicates that this is a copy:
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m Copy and trimmed — note dots on time bar
l EEE R ®® Q ®® T | and blue lines showing in and out points

Inserting or Overwriting

When dragging clip copies from the Viewer to the Canvas, you can either overwrite or insert it at
the playhead’s position. The Canvas display indicates your choices and will become highlighted
when you hover over an option.

Clip being dragged
into the Canvas

Zooming in the Timeline

Change how much is displayed in the Timeline by zooming — it could range from seconds to
minutes and even hours. To focus on just the part of the Timeline you’re working on, zoom in to
display only those clips. You can also make precise cuts using the razor tool by zooming in to
the single frame level.

Zoom in to focus on smaller groupings of clips by pressing cmd-= (equal). Zoom out by pressing
cmd—(dash).

If you can’t see the playhead after zooming, tap the space bar twice (play and stop) to position
the playhead in the center of the Timeline.

Editing Clips in the Viewer

31D
1

The Viewer is usually used to precisely mark the in (press
clip.

) and out (press “0”) points of a

s
1.

Position the playhead at the frame you want for the beginning or “in point” and press

Then position the playhead at the frame you want for the end or “out point” and press “o0”.

Deleting and Gaps in the Timeline
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When you make cuts in the Timeline using the razor tool, remove the unwanted segment by
highlighting it and then use the “delete” key to close the gap.

If you want to leave a gap, use the “backspace delete” key. Try it to see the difference.

An example of a gap after deletion:

=~
] 00:01:30:02

Remove a gap on the Timeline by moving the
playhead to the left end of the gap and press crt-g

Eml.—z — -“ml: | to pull over all the clips to the right.
nal.2 —|-nal2

nal.2 nal.2

Arrow Keys

Move the playhead one frame at a time by using the “left” and “right” keys.
Move the playhead from clip to clip by using the “up” and “down” keys.
Snapping

Pressing “n” turns snapping on and off. It’s important to use this feature when dragging one clip
next to another. When snapping is on it will avoid overwriting the end of the forward clip when
dragging another clip next to it. Snapping makes them line up without gaps.

An example of a clip (shown only as dark gray while dragging) about to be snapped to the end of
another clip — note that the dark triangle below the playhead indicates that you are not
overwriting the clip to the left:
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Notice how little brown
triangles appear when you
drag one clip next to the end
of another. This shows that
snapping is on and that the
clips will connect properly —
end to end without
overlapping or leaving gaps
between.

When dragging the playhead through the Timeline to view or “scrub” the sequence, turn
snapping off to make playback in the Canvas smoother.

Overwriting When Dragging

When dragging clips to arrange them in a new order, it’s possible to overwrite parts of other clips
if you drag one clip over another and let go. Beginners often do this unintentionally so you
should experiment to see the effects of dragging to make sure you have a clear understanding.
Use the command cmd-z to undo mistakes. Notice that there isn’t a dark triangle under the
playhead when overwriting and the part of the previous clip being overwritten turns brown and

purple:



Example of a dragged clip
overwriting the end of
forward clip.

Notice that there aren’t any
brown triangles appearing
on the track.

Playback or Navigation Options

The tiny yellow triangle or “playhead” shows where your are in the time bar in the Viewer,
Canvas, and Timeline.

After clicking in the Viewer, Timeline or Canvas, use the keyboard space bar to start and stop
the playback.

In addition to using the basic VCR control button for playback, there are three other options -
using the “JKL” keys or dragging the playhead or clicking on the time bar.

Use the “JKL” key method of the VRC playback controls:

“J” = rewind
“K”= play
“L”= forward

Drag the playhead in the time bar to “scrub” through the video.

Jump directly to any part of the movie by clicking along the time bar.

27
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A very useful button when reviewing your clip is to the left of the play button and will only play
from the “in” point to the “out” point of a clip:

> OGO6G
= ©h( )G

Use the “play to out” button
for easy playback.
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9. Finishing Your Movie
Gap Checking

Gaps between clips in the sequences appear as black flashes during playback - eliminate them by
moving the playhead into the gap and pressing cmd-g.

Smooth Video Transitions

If you feel that the visual shift from one clip to another is too abrupt, then you can insert a
dissolve from the video transition list in the Effects tab of the Browser - “Cross Dissolve” is a
good one to begin with. This is often used in montages but it is something beginners tend to
overuse. Learn more about its appropriate application by watching where dissolves are used.
Below are the instructions on how to apply them.

Assigning Video Effects Favorites

Designate the most often used effects as a “favorite” to make it easier to apply by following the
steps below:

 nacimiento.3 ' Effects
Name In the “Effects” tab of the
¥ [ Favorites Bin Browser, drag “Cross” and
(&) cross Dissolve Copy Video Transition “Fade In Fade Out” Dissolves
Di'] Fade In Fade Out Dissolve Copy Video Transition into the Favorites folder from
B fin the Dissolve folders below.
> 3D Simulation Bin
v Dissolve Bin
@ Additive Dissolve Video Transition
@ Cross Dissolve Video Transition
@ Dip to Color Dissolve Video Transition
@ Dither Dissolve Video Transition
@ Fade In Fade Out Dissolve Video Transition
@ Non-Additive Dissolve Video Transition
mame _
¥ [ Favorkes . Bl'n Click on Cross Dissolve Copy
. Video Transition to hichlicht it
gnlhignt 1t..

@ Fade In Fade Out Dissolve Copy Video Transition



Silatl Tools Window
Make Favorite Effect

Sequence

Video Transitions
Favorites >
Default - None #T
Set Default
Clear Default

Video Filters
Favorites

Audio Transitions
Favorites

nal.2 nal.2

Seamless Audio Transitions

Under the Effects menu at the
top, click on Set Default in the
Video Transitions grouping.

After assigning a Video
Transition Favorite, move the
playhead between the clips where
you want to add a Video
Transition and press cmd-t to
apply the designated video effect.
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The audio shift between clips can be jarring and often needs an audio cross fade. One (0dB) puts
a short silence space between the two clips and the other (+3dB) mixes audio from both together.
Experiment with the two to see the effect and study how both are used in documentaries. Below

are the instructions on how to apply them.

Assigning Audio Effects Favorites



Drag “Cross Fade (0dB)”
and “Cross Fade (+3dB)”
from the Audio Transition
folder below into the
Favorites folder.

Click on Cross Fade (+3dB)

Copy to highlight it.
Sequence Tools Window Help
Make Favorite Effect AEIF
::"de°l Transitions : Under the Effects menu, click
avorites . .
Default - Cross Dissolve Copy #T on SeF Default n t.he Andio
Set Default Transitions grouping.

Clear Default .
Then use opt-cmd-t to insert the

::"dml Filters : default Audio Transition at the
avorites playhead’s position between the

Audio Transitions > two clips.

Favorites >

Default - None T

Set Default
Clear Default

Audio Filters



Effects can also be
dragged from the Effects
folder onto the transition
point.

The playhead does not
need to be pre-positioned.

Adding Text

Use the Viewer to compose text to identify speakers, add subtitles, beginning titles, and end
credits by clicking on the “A” button and following the instructions below:

The “A” button on the Viewer gives a
@ dropdown listing text options.

Identifying Speakers



Favorites

Bars and Tone (HD 1080i60)
Bars and Tone (HD 25p/50i Full Frame)
Bars and Tone (HD 25p/50i)

Bars and Tone (HD 720p60)

Bars and Tone (NTSC)

Bars and Tone (PAL Full Frame)

Bars and Tone (PAL)

Boris

Matte

Others

Render

Shapes

Slug
D P———
Outline Text
Scrolling Text
Text
Typewriter

Text 1 ||"an Santos I

Font ! Lucida Grande -

Style Pain (5

Size 4'—‘0‘—‘—‘—'—'_',736 ']@[' 2
Tracking 4'—“"""[]""""—',71 ‘]@[' I~
Font Color > @' @' J -]@ P
Text 2 |SI loseph. Sanaer I

Font Lucida Grande {4

Style ' Plain m

Size = —i ﬁ ¢ ]@ P =
Tracking 4'—“"""[|""""—>ﬁ ']@[' -
Font Color > @ @' J ]@[
Background ‘@

A

v

00:14:29;23

Use the “Lower 3rd” option
to identify speakers.

Enter the text for line 1 and 2
using the Control tab of the
Viewer.

Make changes for font type,
style, size, and color for each
text line.

There is also an option to
apply “Background” to the
text lines to make the text
stand out better. In this
example, it’s not used and left
as “None.”
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Beginning Titles

Click the Video tab in
the Viewer to review the
text you’ve entered.

Change the duration for
the text display by
changing the out point.

Drag the text frame
from the Viewer onto
the Timeline at the
position of the
speaker.

The duration of the
text display can also
be changed by
dragging the out point
of the text in the
Timeline.
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Lower 3rd

Favorites

Bars and Tone (HD 1080i60)

Bars and Tone (HD 25p/50i Full Frame)
Bars and Tone (HD 25p/50i)

Bars and Tone (HD 720p60)

Bars and Tone (NTSC)

Bars and Tone (PAL Full Frame)

Bu§ and Tone (PAL) e s .

boris Use the “Text” option on

T the Viewer for beginning

g and end credits.
f:vv:r 3rd
Outline Text
Scrolling Text
Text

Controls " Filt {
Name Parameters Nav -00:00 : ﬂ,‘ ||

=

Procession for the
Virgen de Guadalupe

Fresno, California
December 1995

Text

Enter the text for the
beginning title using the
Control tab of the Viewer.

Font Skia

)
i ik - —| <P Make changes for font type,

Style Plain

Font Color | 3 @ © ‘]@[‘

Origin ® [ [] ]@[

Tracking (e —— ,—1 ]@[ A
A AN &

Alignment Center _PQ-) : Style, SiZC, and COIOI'.

00:00:55:00




o000 Viewer: Text

Video “ Controls | Filters | Motion

Procession for the

Virgen de Guadalupe

Fresno, California
December 1995

Click the Video tab in
the Viewer to review the
text.

Change the duration for
the text display by
changing the out point.

Origin '4—- 0,

-100

Enter a negative number in the right
box of the Origin setting on the
Control tab to raise the text display.

o000 Viewer: Text

Video | Controls | Filters | Motion |

Procession for the
Virgen de Guadalupe

Fresno, California
December 1995

This shows the text position after
changing the Origin setting.

— i Q09
CICIOIOI O i ——

tg

8
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viewer: 1ext

Procession for the

Virgen de Guadalupe i M ‘ o Move the playhead

Fresno, California — Fupe: D s to the beginning of
December 1995 . B

the Timeline.

Drag the text from
the Viewer to the
Canvas over the

- E= “Insert” option and
let go.

@ (m]a e

o|=|Av[ 221 <[ D) T T T T T T T T T

22:15 o506 | 00:00:03;00 00:00:06;00 00:00:09;00 00:00:12 From the Effects tab 11’1 the

Fade In

Browser, drag the “Fade In Fade
Out” transition at the start and
over the transition point.

'Ibn[?

Cross Fi| nal.2

: Drag “Cross Fade (0dB)” audio
=" transition to the beginning of the

- first clip.
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End Credits in Series
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Beginning Title.
Insert as many credit pages as necessary.

Fade into the first credit page from the end of the video.

Cross fade the audio over the transition and out at the end.

Enter the text and change the font characteristic and duration just as with the

Scrolling End Credits
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Scrolling Text

Favorites | 2

Bars and Tone (HD 1080i60)
Bars and Tone (HD 25p/50i Full Frame)
Bars and Tone (HD 25p/50i)
Bars and Tone (HD 720p60)
Bars and Tone (NTSC)

Bars and Tone (PAL Full Frame)
Bars and Tone (PAL)

Boris

Matte

Others

Render

Shapes

Slug

Crawd

Lower 3rd
Outline Text
Scrolling Text
Text
Typewriter

Special Thanks to:

Jose Gonsalez
Maria Lopez
Tony Sanchez

Alicia Torres
Text Directed by
Carlos Vega
Produced by
Amy Morales
Font { Lucida Grande D-T,’
Size Ph 36 point a]@ P
Style { Plain Fﬂ
Alignment | Center %
Color > @ © J "]@ P

~
A

- - |
00:16:48;29

Use the “Scrolling Text”
option on the Viewer.

Enter the text and
change the font
characteristic and
duration just as with
the Beginning Title.
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Special Thanks

Jose Gonsale

The duration time
determines the speed of
the scrolling.

nal.2 [ Fhde Scrolling Text

Scrolling Text

nal.2 | Cros| music

nal.2 | Cros| music

music | Crog

music [ Cros|

Insert the scrolling text at the end.
Fade into the scrolling text from the end of the video.

Cross fade the audio over the transition and out at the end.
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Modify BEELUEGIE Effects Tools Window Help

Render Selection
Render All
Render Only

Video
v == Needs Render
v == Rendered Proxy

V4 Pravyu

Settings...

1ifr «xl

Choose “Render All” and “Both” under the Sequence menu button.

" oesi00 0 00165600 . o0:a7e102

After rendering, the red line is replaced by a purple line,
indicating that it is ready to play back.
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